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About this manual

Documents 
supplied

Complete documentation is provided to help you make
optimum use of the full range of resources offered by your
software.
The online help provides instant access to context-sensitive
help.

The Administrator’s Guide covers the basic concepts to
ensure you to get the very most from the software. It is
designed to provide effective help for administrators, both
first-time and experienced users.

The User’s Guide provides an introduction to using the
application. It is designed to get you off to a quick start with
the software by familiarizing you with the basic concepts
before looking at some of the more advanced functions. 
The documentation is designed for use in conjunction with
the integrated online help.

Administrator’s 
guide

The purpose of this guide is to get you off to a quick start
with the software by familiarizing you with the basic
concepts before looking at some of the more advanced
functions performed by the application administrator.  
The Administrator’s Guide contains four sections covering:

•  Installation procedures
•  Basic principles and description of modules
•  Overview of the User Manager
•  Overview of the Web Manager
•  Overview of Sentinel Manager
•  Overview of Sentinel Controller

The guide describes the most straightforward way of



carrying out specific tasks. For more detail on the different
functions, step-by-step procedures and reference
information, refer to the online help.

Typographical 
conventions

This manual distinguishes between different types of
information using the following conventions:

•  Terms taken from the interface itself, such as
commands, appear in bold.
•  Keys appear in small caps, for example: ”Press the
SHIFT key”.
•  Numbered lists mean there is a procedure to follow.
•  When the conjunction -or- appears next to a
paragraph, it means there is the choice of another
procedure for carrying out a given task.
•  When a menu command contains submenus, the
menu name followed by the command to select appear
in bold. Thus, ”Go to File > Open” means choose the
File menu then the Open command.

This symbol highlights warnings and other impor-

tant information on how a particular command or 

procedure works.

Following this symbol you will find hints and tips for
optimizing tasks, speeding up commands, and so
on.



C H A P T E R  1

Installation

This chapter covers the following topics:

• System Requirements
• Server Requirements
• Workstation Requirements

• Software Protection Key

• Server Installation

• Design/Workstation Installation
• Design/Workstation Installation

• Running the Label Print Manager Service
• Setting up a User Account
• Installing/Uninstalling the service
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System Requirements

When installing SENTINEL, you will install two separate
componants of the program - the Server component and the
Design/Workstation component.

Server 
Requirements

The Server installation allows you to install on your server
the following components: the kernel, Sentinel Manager,
Sentinel Controller and User Manager modules. If you would
like to use the label printing features of your software, you
will need to install a label designer on your server.

The following minimum requirements must be met to ensure
successful installation and operation of the SENTINEL
components:

- Pentium III or IV 500 MHz (1GHz recommended) 
- Microsoft Windows NT Server, Windows 2000 
Server or Windows 2003 Server
- Multi-processor capable
- A SVGA monitor or better
- A hard drive with 200Mb free space  
- A CD-ROM drive
- A Sentinel protection key either electronic (software)
or a  dongle (hardware).

Workstation 
Requirements

The Design/Workstation installation allows you to install 
the  Mapper module and the Query Manager on a work-
station. The workstation components must be installed on a 
computer other than the server. (File mapping and label 
design tasks should not be carried out on the server.)

The following minimum requirements must be met to ensure
the successful installation and operation of the SENTINEL

If you wish to create labels on the workstation, you 

will have to install the label designing software 

separately.
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components

- A PC or IBM compatible computer supporting 
- Windows®  NT or 2000 with 64 MB RAM (128 MB 
recommended)
- Windows®  XP or Windows® 2003 Server  with 
256 MB RAM (512 MB recommended)
- A VGA monitor or better
- A hard drive with at least 150MB free disk space  
- A CD-ROM drive
- A label designer protection key (software or dongle) if 
you intend on creating labels on this workstation.Soft-
ware protection key

The software comes with either a dongle or electronic
protection key that allows it to run correctly and define the
number of available printers. 

Software Protection Key

The dongle is a small electronic device that you simply 
plug into your PC’s parallel port or USB port before launch-
ing the software.

The software key is an authorization code that you input 
when installing the software.

Figure 1 Connecting the dongle to the parallel port of your PC

If you need to use a printer on the same 
parallel port, simply plug it into the soft-
ware protection key. In this case, it may be 
necessary to switch the printer on in order 
for the software protection key to be recog-
nized.
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Figure 2  Connecting the dongle to the USB port of your PC

Server Installation

Server installation allows you to install on your server the 
various modules used to build an automatic data exchange 
solution between your application devicesand our products.  
The server installation lets you, for example, put in an auto-
matic label printing system that will be highly integrated 
with your legacy systems.  

Step 1 Plug the Sentinel software protection key into 
your server.

Step 2 Place the CD-ROM in your server’s CD-ROM 
drive.
 
Step 3 The installation program should launch auto-
matically.
If it does not:
        On the taskbar, choose Start Run then enter the 
letter corresponding to your CD-ROM drive followed by 
CDSETUP.EXE (e.g. D:\cdsetup.exe).

 

USB Port 

Key 

Without the dongle protection key, the pro-
gram will run in ’evaluation’ mode. You will 
able to create only two sentinels and the 
program will be limited to 30 minutes of 
use. If you are using a demo software key, 
you will be given 100 sentinel runs or 30 
days to try the new software.
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Step 4 In the tree structure containing the various 
installation options, select the server option of the 
product you’ve purchased.  

Step 5 Follow the on-screen instructions to complete 
the installation process. 

Step 6 If you want to make use of the label printing 
services of the sentinel server, you will have to install 
the runtime version of the dabel designer.

Design/Workstation Installation

Design/workstation installation installs the Mapper
module, which is used for defining how data exchange will
be done between your application and the SENTINEL
server.  In  the Design/Workstation installation of the product
you have purchased, the Query Manager application will
also be available for installation to set up queries over a
database system that can be executed by the sentinel
server during a data exchange between your datafiles and
the labelling software you are using.

Step 1 Place the CD-ROM in your workstation’s CD-
ROM drive.
 
Step 2 The installation program should launch auto-
matically.
If it does not :
        On the taskbar, choose Start Run then enter the 
letter corresponding to your CD-ROM drive followed by 
CDSETUP.EXE (e.g. D:\cdsetup.exe).

Step 3 In the tree structure containing the various 
installation options, select Design/workstation and then 
the required components.
Step 4 Follow the on-screen instructions to complete 
the installation process. 

If you want to design a label and to use the 

label design option available with the Map-
per, you will have to install the label des-

giner. 



Chapter 1 - 6 Form Viewer User Guide

Running the Label Print Manager Service

The application runs as a service on the host workstation. 
This means it will launch automatically when the worksta-
tion is started.

Step 1 To define the startup options for the SENTINEL 
Service, select Start \Settings \Control panel Ser-
vices and select Label Print Manager 5. 

Select a start method

Choose either:

- Automatic: the service launches when the worksta-
tion is started.
- Manual: the service must be activated manually. You 
will therefore need to open a Windows worksession 
and then launch the service in Control panel Services. 
Select Label Print Manager 5  from the list of services 
and then click on Start.

You must have a protection key installed or have activated 
the product in order to have access to the label creation 
function.

Whatever the start method is, you can control the service 
activity by launching the Kernel from the application pro-
grams group.

If the service is stopped, a start request is sent to the sys-
tem. When the service is started, the application manage-

You must have a protection key installed or 
have activated the product in order to have 
access to the label creation function.

The above start methods launch the service
and the sentinels at the same time. All
available sentinels are thus launched when
the service is started.
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ment icon displays in the system tray. Using this icon you 
can start or stop the service and the different application 
modules as well

Setting up a 
user account

The application must be able to access shared network 
folders and print on network printers. You must therefore 
select a user account to which these rights have been 
assigned.

Step 1 Select a user account then enter the password.

Installing/
Uninstalling the 
service

Once the application is installed, you can always uninstall 
the Label Print Manager service and reinstall it later.

Step 1 To install the Label Print Manager service, 
select Start > Run [name of application installation-
folder] \ TKXKernel50.exe -i.

Unlike the start method using the Windows 

Control panel services, the start method 
from the Kernel does not launch sentinels 

(which would instead be launched from the 

Controller).

The selected account must be declared in 

the local administrator group of the work-
station.

To view sentinel status while the service is
running, simply open a worksession and
then launch the application via the program
group defined during installation. The
default name of the group is the same as
that of the application
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Step 2 To uninstall the Label Print Manager service, 
select Start > Run [name of application installation 
folder] \ TKXKernel50.exe -u.
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Introduction

This chapter covers the following topics:

• Definition of Terms

• Basic Concepts

• How it works
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SENTINEL is a server application dedicated to the data 
exchange between your application and our products.  It 
allows you to, for example, automatically print barcode 
labels created with our labelling software by simply 
exchanging information between your ERP/WMS system 
and the sentinel server  and choosing one of the various 
communication channels that the application offers (File 
transfer, Print transfer, TCP/IP, Web Service, HTTP tras-
fer).

Definition of terms

The application involves a number of specific concepts 
which are explained in the glossary below.

SENTINEL server: PC running Windows™ 2000,
Windows™ NT or XP on which the application is installed.

Input data: data generated by your system. They are
received by Sentinel via a communication channel.

Bearer channel: once launched each sentinel «listens» to 
a specific bearer channel.

Sentinel printer: printer created by the application on the 
print server which users can then designate as the output 
printer in their applications.

Sentinel: procedure used for analyzing and processing 
data generated by your application.

Mapfile: describes the method the sentinel will use for ana-
lyzing datafiles.

Plug-in: process module executing a specific task during a 
sentinel process.
There are four types of plug-ins:

- The Input plug-in: listens to a data bearer channel 
supplying a sentinel.
- The Process plug-in: processes information 
retrieved from input data.
- The Report plug-in: informs users and updates a 
report about sentinel process.
- The Output plug-in: back ups or transmits input data
to a file
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Basic concepts

The application monitors data communication channels
connected with your system. As soon as a channel receives
data, the application analyzes the incoming data and
processes them through one or more process plug-ins.  The
communication channel has to be chosen according to your
application and the input plug-in you have at your disposal.

How it works

The application runs as a Windows™ background task. 
This application is considered a service by the system and 
can thus be launched with the system. Sentinels are used 
to define analysis and printing tasks. Once launched each 
sentinel monitors the bearer channel for which it has been 
configured. When data coming from your system are 
received on the bearer channel, the analysis and process 
activity begin.

Input data are filtered by the map file of the sentinel. As for 
each printing request, input data information is sent to the 
differnet Process plug-ins configured for the sentinel.
At the end of the process, input data are sent to the output 
plug-in in order to be transferred or saved.
During each step of the process and after sentinel valida-
tion, information concerning the sentinel process is sent to 
the report plug-in
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.

Figure 3 Input and Process Plug-in flow
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The application modules

This chapter covers the following topics:

• The application Modules
• Web Manager
• User Manager
• The Kernel
• Sentinel Manager
• Sentinel Controller
• Mapper
• Query Manager
• Plug-ins

• Brief overview: from mapfile creation to label printing
• On your workstation
• On the server
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The application modules can be cassigied into 3 categories 
depending on their usage in the software.  

The first category comprises of the kernel module, the 
controller,  Sentinel Manager, the user manager and the 
Web Manager application.   All of them are used to create, 
configure and run SENTINEL processes.  They all come 
with SENTINEL’s server installation.

The second category comes included with the workstation 
installation.  It comprises of two applications: The Mapper 
and the Query Manager.  Both are used to preset the con-
figuration files for the defined sentinels by the server. 

The third category is the Plug-in modules.  Plug-ins are
thin application modules dedicated to accomplish one
unique task.  They performe all the actions a sentinel is
configured to do.  They are installed by the both the server
and designer installations. 

The application modules

Web Manager The Web Manager acts as an interface to the SENTINEL 
Server over the internet/intranet.  It allows the user to inter-
act with any SENTINEL Server, regardless of its location, 
via their internet browser by typing in the web application’s 
address in the browser’s address line. 

User Manager The User Manager secures the internet connections to the 
SENTINEL server, by allowing an administrator to set per-
missions for application users. 

Kernel Kernel is the core application that manages all other tasks, 
including launching sentinels and monitoring sentinel activ-
ity. If Kernel is closed, all sentinels will be disabled. 
Kernel operates as a background task and can be config-
ured to launch automatically when your workstation is 
started up. It is therefore not necessary to open a Windows 
work session for the application to run. 
Once launched from the application program group, the 
Kernel module appears as an icon on the Windows taskbar.

You can access Sentinel Manager and Sentinel Controller 
via the Kernel menu.
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Step 1 Right-click on the Kernel icon .

Step 2 Choose the required module in the menu.

Sentinel 
Manager

Sentinel Manager is launched via the Kernel menu and 
allows you to create, configure and manage the sentinels 
that will analyze your datafiles.

Sentinel 
Controller

Sentinel Controller is launched via the Kernel menu or Sen-
tinel Manager. It allows you to view sentinel status, enable 
or disable individual sentinels and display the error logfiles. 

Mapper Mapper allows you to create and configure the mapfiles 
which will analyze your datafiles. A mapfile describes the 
structure of the datafiles for analysis and assigns the 
mapped data to the corresponding variables in the initial 
document. Mapper is accessed via the application program 
group or Sentinel Manager. 
Mapper features an integrated wizard to guide you through 
the process of creating and configuring mapfiles.  See the 
User’s Guide for a full description of the module and exam-
ples of how to create mapfiles.

Query Manager This application module lets you define queries over differ-
ent database systems and lets you group them into tasks 
that can later be invoked by a sentinel through the use of 
the database process plug-in.
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Brief overview: from mapfile creation to label printing

Here is a general overview of the main steps to take in 
order to configure a sentinel that will receive text files into a 
specific forlder and will print the corresponding barcode 
label.

On your 
workstation

Step 1  use the Mapper module to: 

- Define the structure of the files that will be used for label
printing (known as ”mapfiles”).

- Design the labels directly in the labelling software.

- Test the map

On the server Step 1 use Sentinel Manager to: 

- Create sentinels that will analyse your data files

- Define their properties and the properties of the plug-
ins associated with them

- Enable sentinels for starting

Step 2 use Sentinel Controller to: 

- Enable individual sentinels

- Launch printing

- Monitor printing

-or-

Use the Web Manager, via the web, to create, define,
enable and launch sentinels.  The Web Manager acts as an

The Create a document feature is not 
available with all labelling software pro-
grams. Therefore, you may need to manu-
ally open your labelling software and create 
your label directly in the labelling software.



The Application Modules Chapter 3 - 17

online Sentinel Manager and Sentinel Controller all rolled
into one.  However, monitoring via a real-time logging
cannot be done online. 
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User Manager

This chapter covers the following topics:

• Launching the User Manager

• Adding New Users

• Defining or Changing User Rights

• Changing a password
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In order to secure the SENTINEL server’s internet connec-
tions, the User Manager will allow an administrator to set 
permissions for application users.  The different types of 
permissions include:

- Administrate:  allows the user to launch the Security 
Management Module and change the rights of other 
users.

- Manage: allows the user to add, remove or configure 
sentinels as well as enable/disable sentinels.

- Operate: allows users to start/stop sentinels.

- Control: allows the user to view sentinel activity via 
the Web Manager without any right to alter the settings 
or activity of the sentinels in any way.

Launching the User Manager

You can launch the User Manager by going to Start > Pro-
grams > Sentinel 5 > User Manager.

Adding new users

Once you’ve launched the User Manager:

Step 1 go to User and select Add... 
A box will pop-up prompting you to enter a user name.
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Step 2 Click OK.  
You will see that the user has been added to the list 
however, no permissions will have been defined.  

Defining or changing user rights

Select the user who’s rights you want to set or change. 
 

Step 1 Go to User

Step 2 Select the highest level or rights you want to 
assign the user.

If you would like to give a user the ability to start/stop senti-
nels, you would select Operate from the list of available 
permissions. You will notice that “Yes” appears for each 
right given to the user. In this case, you would see “Yes” 
under Operate and Control, but not under Manage and 
Administrate

Changing a password 

The User Manager also allows you to change the password 
assigned to users.  

Step 1 Go to User

Step 2 Select Change password

Step 3 Enter the old password

Step 4 Enter a new password
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Web Manager

This chapter covers the following topics:

• User Interface

• Permissions

• Using the Web Manager
• Creating or Modifying an existing sentinel
• Sending out the sentinels
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The Web Manager is the user interface with the SENTINEL 
Server.  It can be accessed by any user, from any browser, 
anywhere in the world, as long as that user has been given 
permission, a username and a password by the administra-
tor.  

The Web manager can be installed on a different server 
from the one SENTINEL Server runs on.  Installing them on 
seperate servers ensures that:

- The deployment and maintenance of the Web Man-
ager application is easier and runs smoother since a 
single web server can administrate multiple SENTINEL 
servers on the network.

- They are each running at full power by giving the 
Web Manager and the SENTINEL Server their own 
server.  Depending on the number of opened sessions, 
the Web Manager can consume a lot of processor time 
which may hinder the power of SENTINEL Server.

- The Web Manager can run on an already existing 
web server.

User Interface

Typing in the Web Manager’s URL in the browser will dis-
play the Data Exchange Server’s login page. 
l

Figure 4 Web Manager’s login screen
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This page is the gateway to the Sentinel Control and Con-
figuration page.

Step 1 Enter a valid Username and Password (these 
have been configured and given to you by an adminis-
trator)

Step 2  Select the name of the SENTINEL Server you 
want to work with

Step 3 Click Connect

The selection of the server ise done from a combo box.  
This combo box is linked to a file, that the administrator has 
configured, which  lists the available SENTINEL Server 
names and the associated TCP/IP port to be used (if no 
port is specified, a default port will be used instead).
If your connection is successful, a page listing all the senti-
nels defined on the SENTINEL Server will be displayed.  If 
not, please try again, or contact your administrator to verify 
that your username and password are correct.

Figure 5 Sentinel list screen

Permissions

The administrator can set up your account to give you 
some or all of the possible permissions. 
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Depending on the permissions you have been given, your 
account may allow you to:

- Create a new sentinel
- Delete one or more sentinels
- Edit or modify the settings of a particular sentinel
- Enable one or more sentinels
- Disable one or more sentinels
- Start one or more sentinels
- Stop one or more sentinels
- Refresh the Web Manager

The following icons are to be used for the above mentioned 
functions:

  Create a new sentinel

  Delete one or more sentinels

  Edit or modify the settings of a particular sentinel

  Enable one or more sentinels

  Disable one or more sentinels

  Start one or more sentinels

  Stop one or more sentinels

  Refresh the Web Manager

The Web Manager’s refresh button must be used 

to refresh the screen and to show up-to-date 

sentinel information and status.  It is advisable 

NOT to use the browser’s refresh button as it will 

only re-perform your last command/request: it 

may not refresh the data. A time and date stamp 

is available at the top of the screen to inform the 

user when the last update took place.
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Using the Web Manager

Once the user has successfully logged in, a list of available 
sentinels will be displayed.  Just like in the Sentinel Man-
ager, the group name, the sentinel name, its state and 
whether or not the sentinel has been enabled will be dis-
played on the screen. 

One or multiple sentinels can be selected by clicking in the 
check box - a check mark will appear to show that it has 
been selected and the selected sentinel(s) will change to 
the color orange. Clicking in a group box will automatically 
select all the sentinels belonging to that group.  Disabling a 
sentinel will change the ‘enable’ box color to red. Starting 
the sentinel will change the ‘state’ box to green.  In an 
unselected, enabled and stopped state, the sentinel 
remains in the default color - white. 

The icons below the list can be used to perform a number 
of tasks as long as the user’s account has the permission to 
do so.

Creating or 
Modifying an 
existing 
sentinel

Clicking on the “Create new sentinel”   or selecting a 

sentinel and clicking the “Edit/Modify sentinel”   icons 

will bring up the sentinel configuration screen.  Here, the 
user can select the sentinel’s input/output/process/report 
plug-ins.  Clicking on the oil can icon    will 

take you to the plug-in settings’ screen.
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Figure 6 Plug-in settings screen

Only one input plug-in can be selected for each sentinel, 
however, you can select as many output, process or report 
plug-ins as you would like.

Once the configuration has been completed, click on the 

 to return to your list of sentinels.

Sending out the 
sentinels

To send out the sentinels, you must :

Step 1 Select the sentinel(s) you wish to activate by 
clicking in the appropriate check box.

Step 2 Click on  to enable the selected sentinel.

For more information on the different plug-ins
and their settings, please see ‘Appendix A - plug-
ins’  in your Administrator’s Guide. 
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Step 3 Click on  to start the selected sentinel(s). 
The screen should automatically refresh to show the 
state of the sentinel(s) as “running”.

Clicking on  will disable the selected sentinel(s), mak-

ing it impossible to run.  Clicking on  will stop the 
selected sentinel(s).  To verify that the sentinel has indeed 

stopped, click on  to refresh the screen and see the 
latest update.  

Stopping sentinels may take a few seconds. The 

more sentinels you stop at one time, the longer  

it may take.  If you have clicked on the refresh 

button and do not see the correct state of the 

sentinels displayed, please wait a few moments 

and refresh again.
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Sentinels

This chapter covers the following topics:

• What are Sentinels and how do they work?

• How it works
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What are sentinels and how do they work?

A sentinel is simply a group of settings the application uses 
to intercept and process the informatin coming from your 
application and devices. 

Once activated, each sentinel acts on your system as an 
analyzing and processing service giving you the ability to 
exchange data between your application and the Teklynx 
product in order to build a complete automatic ID solution.

Each sentinel must specify:  
- A bearer channel on which your printing requests will 
be received
- A method for data analysis given by the mapfile 
selection associated with a sentinel
- One or several types of processes to be implemented 
for each information block identified in the input data 
according to the sentinel mapfile
- One or several types of logs to be generated when a 
specific event is detected during  analysis or during 
input data process
- One or several types of backup input data once they 
have been treated

A sentinel must belong to a group. Each group can contain 
as many sentinels as your organization requires. The orga-
nization of sentinels within a given group is just performed 
for organizational purposes.

How it works

You have selected, for your sentinel, an input plug-in and 
one or several process, log or output plug-ins.

When the sentinel is activated, the input plug-in is also acti-
vated and it monitors its bearer channel. When information 

The choice of possibilities for communication
channels, type of process, type of log generated,
and type of backup will vary depending on the
labelling software version you are using and the
plug-ins available for that product launch. 
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is received on its channel, the plug-in sends input data to 
the core application. Data are then analyzed according to 
the mapfile associated to the sentinel.
For each information block detected, the core application 
sends data to the different plug-ins associated with the sen-
tinel. Data are treated according to the order sets up in the 
sentinel. Once data are treated, the analysis goes on 
towards the next blocks. The same process is repeated 
until all the data have been processed.
The core application sends data received by the input plug-
in to the different output plug-ins. These plug-ins are config-
ured to implement the different backup processes.
For each step of the process, the core application gives to 
the log plug-ins selected by the sentinel, the activity param-
eters of the sentinel.

The diagram below shows how this works.
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Sentinel Manager

This chapter covers the following topics:

• Launching the Program

• Description of the main window
• Menu Bar
• Workspace
• The Toolbar

• To select a tool

• Interface settings
• Changing Display Option
• Changing the Interface Language
• Adjusting column width
• Adding a sentinel
• Defining the properties of a sentinel

• Managing Sentinels
• Duplicating a Sentinel
• Deleting a Sentinel
• Activating a Sentinel
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Launching the program

Once launched from the application program group, the 
Kernel module appears as an icon on the Windows taskbar.

To access Sentinel Manager:

Step 1 Right-click on the Kernel application icon .

Step 2 Choose Sentinel Manager in the menu.

The main Sentinel Manager window appears.

Figure 7 Sentinel Manager

Description of the main window

This section presents a general overview of the main ele-
ments that make up the interface, as they appear in the 
main window at the beginning of a work session. 

Menu bar The menu bar comprises four drop-down menus: Sentinel,  
View, Tools and Help.
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Workspace The workspace occupies the central part of the main win-
dow. The list of sentinels is displayed in this area as a 
table.

The toolbar These tools allow you to execute routine tasks more quickly 
than using the menus. 

•  To select a tool Click on the button corresponding to the tool.

Interface settings

Changing 
display options

You can display the interface in English or French. You can 
also modify column widths and select a display filter.

Changing the 
interface 
language

Step 1 Choose Tools > Options.

Step 2 Select the required language in the language
zone.

A checkmark shows which language is selected.

Adjusting 
column width

Place the cursor over the column’s right-hand border in the 
table header and drag it to the left or right to obtain the 
required width. 

Adding a 
sentinel

Choose Sentinel > New.
The new sentinel appears in the table. Its status is defined 
as ”under construction”.

To access commands using the keyboard,
use the keyboard shortcuts. Press ALT plus
the key corresponding to the letter
underlined in the menu name, then the key
corresponding to the letter underlined in the
command name.
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Defining the 
properties of a 
sentinel

The General tab allows you to assign a name to the new 
sentinel, add any comments and associate it with a group 
and a map file.

Step 1 Enter a name in the zone Name.

Step 2 In the zone Group, select a group or type a 
group name. If needed, type comments.

Step 3 Select the map file defining the structure of 
your data file.

Step 4 Check the Stop on errors box if you want a 
sentinel process to be stopped when an error occurs.

The others tabs allow you to define which plug-in you want 
to run for the Input, the Output, the Process and the Report.

If you want more information about the plug-ins, please 
refer to  Appendix A:plug-ins at the end of this manual.
You will also find information about the plug-in selected in 
each tab of the sentinel properties dialog box. 

Managing sentinels

Sentinel Manager allows you to carry out a number of 
operations, including duplicating an existing sentinel.

Duplicating a 
sentinel

Select the sentinel.

Step 1 Right-click on it.

Step 2 Choose Duplicate in the context menu.

The duplicated sentinel appears in the list with the same 
name followed by copy no. x.

Deleting a 
sentinel

Sentinel Manager also allows you to delete sentinels.

Step 1 Select the sentinel.

Step 2 Right-click on it.
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Step 3 Choose Delete in the context menu.

Activating a 
sentinel

In order to activate a sentinel (from the service or from the 
Sentinel Controller), you must first enable it in the Sentinel 
Manager.

If you want that a sentinel be processed in the Sentinel 
Controller, it should first be activated in the Manager.

Step 1 Select the sentinel.

Step 2 Check or uncheck the box in the Enable col-
umn. If you check this box, the activated sentinel will 
appear in the Controller.

Step 3 You can launch the Sentinel Controller from 
the Tools menu of the Manager or click on
 

For more information, please see the chapter Sentinel Con-
troller.
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Sentinel Controller

This chapter covers the following topics:

• How Sentinel Controller Works

• Launching the program

• Description of the Main Window
• Menu Bar
• The Sentinel List
• The Toolbarl
• Selecting a Tool
• Information Panel
• The Status Bar

• Interface Settings
• Changing Display Options
• Adjusting Column Width
• Displaying a Specific Group
• Modifying the Display Order
• Displaying Sentinel Properties
• Activating one or more Sentinels
• Deactivating one or more Sentinels

• Sentinel Status
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• Task Management
• Viewing Current Tasks
• Cancelling a Task

• Error Management
• Structure of the Error Logfile
• Error Messages
• Deleting an error logfile
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How Sentinel Controller works

Sentinel Controller allows you to view sentinel status, 
enable/disable individual sentinels and display the printing 
and error logfiles.
Sentinels are created and set up using Sentinel Manager. 
When you modify the properties of a sentinel, the changes 
are automatically updated in Sentinel Controller. Once 
enabled in Sentinel Controller, the sentinel is assigned 
Activated status in Sentinel Manager and cannot be modi-
fied while running.

Launching the program

You can launch Sentinel Controller via the Kernel menu 
or Sentinel Manager. 

To access Sentinel Controller:

Step 1 Right-click on the Kernel icon .

Step 2 Choose Sentinel Controller in the context 
menu.

Figure 8 Sentinel Controller 
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Description of the main window

This section presents a general overview of the main ele-
ments that make up the Sentinel Controller interface, as 
they appear in the main window at the beginning of a work 
session. The main window is divided into two areas: 

- The sentinel list
- The information panel

Menu bar The menu bar comprises four drop-down menus: Sentinel, 
Edit, View and Help

The Sentinel list The sentinel list occupies the central part of the main win-
dow and is displayed as a table.

The toolbar These tools allow you to execute routine tasks more quickly 
than using the menus.

Selecting a tool Click on the button corresponding to the tool.

Information 
panel

The information panel, located in the lower part of the win-
dow, comprises of three tabs which display information on 
pending tasks and the printing/error logfiles respectively. 
You can show or hide the information panel using the com-
mand View Information or the Information tool .

To access commands using the keyboard,
use the keyboard shortcuts. Press ALT plus
the key corresponding to the letter
underlined in the menu name, then the key
corresponding to the letter underlined in the
command name.



Sentinel Controller Chapter 8 - 45

The status bar Located along the lower edge of the window, the status bar 
displays the number of pending tasks plus the date and 
time. 

Interface settings

Changing 
display options

You can modify column widths and/or select a display filter.

Adjusting 
column width

Place the cursor over the column’s right-hand border in the 
table header and drag it to the left or right to obtain the 
required width. 
- or -
Double-click on the column

Displaying a 
specific group

You can display sentinels belonging to a particular group.
Choose View Group/All groups  and then the required 
group of sentinels.
- or -
Select the option directly on the toolbar.

Modifying the 
display order

Click on the header of the column by which you wish to sort 
the sentinels.

Displaying 
sentinel 
properties

You can display the properties of a sentinel.

Step 1 Select the sentinel.

Step 2 Choose View Information

Step 3 Click on the Properties tab

You can move the border separating the sentinel
list and the information panel by dragging it with
the cursor.
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Activating one 
or more 
sentinels

Step 1 Select the required sentinel(s) using the mouse 
or the Select all and Invert selection commands. 

Step 2 Click on the  tool  to activate the selection  

- or -
Choose Sentinel Activate.

Deactivating 
one or more 
sentinels

Step 1 Select the required sentinel(s) using the mouse 
or the Select all and Invert selection commands.

Step 2 Click on the  tool  to deactivate the selec-
tion  
- or -
Choose Sentinel Deactivate.

Sentinel status

Task 
management

The Information panel allows you to monitor the progress of 
current tasks.

Unlike sentinels activated by the service, all 

sentinels launched manually will stop pro-
cessing when the application is closed.
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Viewing current 
tasks

Activate the Information panel and click on the Jobs tab.

Cancelling a 
task

You can cancel a task using the information panel.
Select the task you wish to cancel then press the DEL key.

Error Management

When Sentinel Controller detects an error during datafile 
analysis, it updates the relevant error logfile located in the 
application LOGFILES folder. The filename of the logfile will 
be that of the sentinel. The logfile describes the nature of 
the error so you can rectify it if necessary.

To view the error logfile for the selected sentinel, display 
the Information panel, and then click on the Log tab.

A symbol appears next to each sentinel in the list 
to indicate its status.

This symbol indicates the sentinel is deactivated.

This symbol indicates the sentinel is about to begin 
analysis.

This symbol indicates the sentinel is under con-
struction.

Define the missing settings in Sentinel Manager.

This symbol indicates the sentinel is activated.

This symbol indicates the sentinel is processing a 
datafile.

Cancelling a task will permanently delete the 

datafile currently being processed.
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The Error column and the sentinel symbols indicate any 
errors encountered during datafile analysis.
To reset the error counter, right-click on the sentinel and 
then choose Reset error counter in the context menu.

Structure of the 
error logfile

This file allows you to monitor file processing status.

Error messages Error messages inform you of the nature and source of any 
errors so you can rectify them.Error messages include the 
error number, the date and the time, the name of the file 
concerned, and the error message.

Deleting an 
error logfile

You can delete error logfiles using the Information panel.

Step 1 Select the sentinel to which the error logfile is asso-
ciated.
Step 2 Click on the Information panel Log tab then press 
CTRL + SUPPR.

Deleting an error logfile will permanently 
remove the .log file.
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A P P E N D I X  I

Plug-ins

This appendix covers:

Information about the configuration and selection of the
different plug-ins; 

• Input
• File capture
• TCP/IP port listening
• Print capture
• Web Server

• Process
• Label printing
• Database
• Web service client

• Output
• Transfer plug-in

• Report
• Log file
• E-mail
• TCP/IP port listening
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Input plug-ins

You have three input plug-ins at your disposal:
- File capture
- TCP/IP port listening
- Print capture
- Web Server

File capture This plug-in collects files in a specific folder.
Files are processed in chronological order - the first file to 
appear in the folder is the first file processed. 

From the Input tab of the sentinel properties dialog box, 
select the input plug-in and click on Settings.

The following dialog box appears:

To be analyzed by the sentinel, the file must 
be accessible in read/write mode. In addi-
tion, the sentinel must have full control over 
the data file before it will proceed with pro-
cessing (i.e., the program that is creating 
the data file for sentinel must be finished 
writing the file).
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Step 1 Type or select the file path of the folder to be 
watched.

Step 2 Type file name or file extension of the files to be 
captured.

You can type several files names separated by a semi-
colon or use wildcard characters. Asterisk (*) is used to 
replace zero or several characters. Question mark (?) is 
used to replace one and only one character in a file name

Examples 

Step 3 Choose your watch method:

- wait for file system events: in this mode the 
application is suspended until the system 
«awakes» when a file is in the directory. At that 
time, the file processing starts.

- check on time interval: the folder is watched at 
regular intervals.

TCP/IP port 
listening

This plug-in is viewed as a Socket server and receives data 
from a client in a pre-defined format. For more information 
about this format, please refer to the example available in 
your installation directory. This plug-in can be considered 

a*.txt All files with extension txt starting
with a (or A), like AF104.txt or a.txt.

item_n?.* All files named  item_n + one
character, whatever the extension,
like item_n3.dat or ITEM_NZ.txt, but
not item_n24.doc

*.txt;*.dat All files with  extension txt and dat

This method is a good way to limit the
resources needed by the application.
However, this method cannot always be
used. Some file systems, such as shared
folders on AS400, are not compatible with
the Windows notification system.
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as an input and/or report plug-in. It allows client application 
to retrieve printing status. This plug-in can support any kind 
of platforms.

From the Input tab of the sentinel properties dialog box, 
select the input plug-in and click on Settings.
The following dialog box appears:

•   How does this 
plug-in work?

Step 1 The client tries to connect

Step 2 The server validates the connection

STep 3 The client sends a data process request

Step 4 The server sends the events linked to the file 
process

Step 5  The server sends the end of process

Step 6 The client disconnects or continues sending 
information to te sentinel

If this plug-in is considered as both an input and report 
plug-ins, events reported by the server to the client will 
concern only this client.

•   General message 
format

A message is sent to exchange information between the
client and Socket Server. The structure of this message is
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defined below.

•   Data format 
description

Data sent will have the following format:

variable name = CRLF value

The variable name is the name of a variable on your label or
that of a control variable:

@LABEL_NAME: used to indicate the label name to 
be printed.
@PRINTER_NAME: used to indicate the target printer.
@LABEL_QUANTITY: used to indicate the number of 
labels to be printed.

If you want to send several process demands during the
same information exchange, data blocks must be separated
by a CRLF (ASCII characters 10 and 13).

If there are several blocks of data, blocks are separated by
CRLF:

variable name 1 = value CRLF
variable name 2 = value CRLF
variable name 3 = value CRLF
CRLF
variable name 1 = value CRLF
variable name 2 = value CRLF
variable name 3 = value CRLF
variable name 4 = value CRLF

Message size (includ-
ing those four char-
acters)

4 characters (long)

Command number 4 characters (long)

Parameter 1 4 characters (long)

Parameter 2 4 characters (long)

Job name 260 characters (char [260])

Data varying length
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•  Messages list Connection demand

The connection string indicated in the plug-in configuration
is aimed at allowing the client to connect to the server.

Job demand

Answer to connection demand

Once the connection demand has been made, the client
must wait for an answer from the server in order to continue.

Command number 0

Parameter 1 0 (message with Ansi charac-
ters)

1 (message with Unicode 
characters)

Parameter 2 Client ID. Optional parameter 
used to check information 
sent from the server to the 
client.

Name not used

Data connection string

Command number 2

Parameter 1 0 (message with Ansi charac-
ters)

1 (message with UNICODE 
characters)

Parameter 2 not  used.

Name Job name

Data data to process

Job name Client ID

Command number 1
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Answer to job demand

Parameter 1 0 (OK)

1 (false connection string)

2 (maximum number of clients 
reached)

Parameter 2 Not used

Name Not used

Data Not used

Command number 3

Parameter 1 0 (OK)

1 (cancelled)

2 (message)

3 (error)

4 (end of process)

Parameter 2 See table below

Name IP address or client’s PC name 
+ client ID (value set during 
connection)

Data Text message linked to the 
receiving of an error or a mes-
sage. The module name or the 
name of the plug-in is defined 
before this message.
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 Details about parameter 2

Communication between the client and the server can either
be done in UNICODE or in Ansi. If client data are sent in
UNICODE, the server will answer in UNICODE. It is the
same process for ANSI

•  Server 
disconnection

The client will be disconnected:

- For the input, if the client tries to send a new process
without having received the end of process of the
previous demand.

- For the report plug-in only, if the client tries to send 
data.

Print capture This plug-in captures spooled tasks on a printer. This 
printer is set up during your plug-in configuration. All printed 
tasks printed from your system to the printer will be ana-
lyzed by the sentinel once activated.

On message recep-
tion and according to 
what has been 
selected in the 
Report plug-in.

0 (sentinel stopped: client dis-
connected)

1 (data received)

2 (data to be processed)

3 (data are sent to the output 
plug-in)

4 (free message)

On error reception 3 (format not supported)

4 (process error)

On end of process Equal to the NewData return 
value

0 (OK)

1 Process canceled

6 Process error

7 Output plug-in error
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Printing your document from a Windows application on a 
"SENTINEL" printer may modify the original document. For 
instance empty lines can be removed and tabulation char-
acters can be replaced by a carriage return line feed 
sequence In order for the map to read the "reformatted" 
data correctly, do the following:

Step 1 Start by making the "SENTINEL" printer avail-
able for printing, as it is by default suspended for the 
capture.

Step 2 Select the FILE port for the output.

Step 3 Print your document on this printer from your 
application.

At print time a dialog box is displayed that lets you specify 
the output file name.

Step 4 Use the file that is printed as the WorkFile to 
define the Map file.

This method allows for the modifications that could occur 
during the printing process.

Step 5 When the map file is done, don't forget to set 
the printer back to suspended mode and to select the 
COM1: as the output port.

From the Input tab of the sentinel properties dialog box, 
select the input plug-in and click on Settings.
The following dialog box appears:
Select printer spool for input.

When printing through the TCP/IP protocol, 
the original document is not modified 
through the use of the driver. In that case 
it is possible to create the map file with the 
original document.
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Step 1 Select printer spool for input.

Step 2 If you want to add another printer, enter its 
name and click on Add. The new printer appears in the 
printer spool for input list.

Step 3 Click on OK to validate.

Web Server

Note

Depending on the product version you have purchased, 
this plug-in may not be available 

This plug-in allows the SENTINEL Server to receive infor-
mation from a webpage, previously created and configured 
for data collection.  It allows the SENTINEL Server to be 
connected to any Web Application with a minimum of inte-
gration work on the Web Application itself.  All it would take 
is for a “Submit” button on a webpage to be connected to 
the server’s URL.  This would send all the information 
entered in the webpage to be collected and, for example,  
inserted into a database or transmitted to a webservice 
available on the ERP system to perform a particular trans-
action.  Since this plug-in acts as an HTTP server, it will 
answer an HTTP POST message and will call the assigned 
process plug-in to act according to the information.  The 
web form will, however need to be customized to link the 
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data collected on the web page with the information 
requested by the process plug-ins used by the sentinel. 
 

In order to customize a web form, three things must be 
done:

1. Create standard input fields, giving them the name 
of the variables you want to addess from the fields.  

Example:  

<input type= “edit” name= “variable_name” value=
“variable_value”>

For more details, please see the html sample web form in 
the sample program directory.

2. Create three input fields named Group, Sentinel and 
Job Name that are used to identify the sentinel which 
will receive the  data and to provide a name for the job.

Example: 

<INPUT type= “edit” name= “Group” value= “Production”>

<INPUT type= “edit” name= “Sentinel” value=”S01”>

<INPUT type=” “edit” name “JobName” value=”Job2545”>

Data will be processed by the sentinel “S01” of the ”Produc-
tion group”.  The Job will be refered to as being “Job2545”. 



Appendix A - 60 Administrator’s Guide

3. Customize the method and action parameters for 
the form so that it could be linked to the SENTINEL 
Server.

Example:

<form method= “post” action=
“http://sentinel_server:port_number/des”>

...

...

...

</form>

Each input field name and value will be sent to the sentinel.  
Then,the sentinel will tell the caller (usually the web 
browser) to call back to the web server’s normal address.  It 
allows the data to pass through the sentinel, first, and then 
again through the web application is it has been designed 
on a web server such as IIS or Apache.  

Another way to exchange information between your appli-
cation and the SENTINEL server through the web server 
plug-in is to directly use the SENTINEL web service that is 
published.  From a developement patform that supports 
web serve calls, like .NET or J2EE, you can directly invoke 
the function exposed by the SENTINEL web service.  To do 
that, you simply need to provide the URL address of the 
SENTINEL web service:  http://sentinel_server:portnumber/
service?wsdl   Your development tool should create a 
wrapper containing two methods and an enumeration 
(function result):

Process1 (
Group as string            : name of the sentinel group
Sentinel as string         : name of the sentinel
JobName as string        : job name to be displayed
Values as ArrayOfString : array of strings
) as FunctionResult
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array of string example: array( “Name”, “McCarthy”, “Sur-
name”, “Doris”)

Process2(
Group as string          : name of the sentinel group
Sentinel as string       : name of the sentinel
JobName as string     : job name to be displayed
Values as string         : string representation of values
) as FunctionResult

Values: “Name=McCarthy\r\nSurname=Doris\r\n” where 
“\r\n” represents CrLf (Carriage return, Line feed).

FunctionResult enumeration:

OK                 : process has been done successfully
Canceled        : process has been cancelled
Err_Process     : process raised an error
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Process plug-ins

Three process plug-ins are available:
- Label printing
- Database
- Web service client

Process plug-ins are used to determine the way in which 
your information will be processed.  Process plug-ins man-
age variable collections to perform the work they have been 
designed for.  Variables are of two types:

Standard: 
- the Label printing plug-in , for example, manages 
variables defined in a label created with the label 
designer.  
- The database plug-in manages variables assocated 
with a task that is defined with the Query Manager.  
- The Web service plug-in manages variables associ-
ated with the parameters of a web service function.  

Control: These are the variables that can influence the pro-
cessing work of the plug-ins.  

- Label printing plug-in uses, for example, the 
@LABEL_NAME variable to define the label to print.  
@PRINTER_NAME to select the target printer...
- Database plug-in uses the @TASK control variable to 
select the task to execute.
- Web Service plug-in uses the @WEBMETHOD con-
trol variable to select the web service method to exe-
cute. 

Label prin ting This plug-in prints barcode label with data found by the 
mapping.
From the Process tab of the sentinel properties dialog box, 
select the process plug-in and click on Settings.
The following dialog box appears:
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Step 1 From the Printers tab, select the printer(s) you 
want to use.

You can define there one or more aliases for a printer. For 
example if you define "Production1" as an alias for the 
printer "Plasmatronic TH640, \\ServerProduction1", SENTI-
NEL will select this printer if the data analysis found the 
data Production1 as the printer name to use for printing.

If later the printer is changed for a different model, you will 
just have to assign the alias to the new printer in the plug-in 
configuration. No modification will need to be done on the 
data.

Step 2 In the Default values tab, type or select, if 
needed, a file to be printed.

The alias is used prior to the real name of 
the printer. For example, if you want to 
redirect the printing demands from the 
"Plasmatronic TH640"  to the "Matrix Code 
IV", you simply need to assign the alias 
"Plasmatronic TH640" to the "Matrix Code 
IV" printer.
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Step 3 Select a default printer on which documents will 
be printed if no printer is specified in your data file.

Step 4 Fill in, if needed, the number of labels to be 
printed, the number of copies, etc.

Step 5 Click on the Options tab and activate the 
When opening a document, clear its variables 
option if you want to erase the variable values saved in 
the document when it is opened. If not, the values 
saved in the document will remain until new values are 
provided by the file analysis.

The data used from one document is opened only once and 
is not used again. (The variable data are not propagated 
between multiple jobs.) Therefore, if you want data from 
one document to be included in the next job, you will need 
to include it in both documents.

Step 6 Click on OK to validate.

Database

Note

To use this plug-in, you require an additional license.  
Please contact your reseller to activate this 
functionality and ensure your database system is 
supported.

The Database process plug-in allows a sentinel to execute 
queries and call stored procedures over different database 
systems with the information received from the input plug-
ins.  Queries are defined at design time on the workstation 
using the Query Manager application.  

Once the queries have been created they can be associ-
ated with stored procedured and called into a task.  Task 

Remember that first priority is given to the 
control variables found in the file, then to 

the default value such as this one.
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and query definitions are saved into two configuration files 
(task.xdb, database.xdb).  These files must be used from 
the SENTINEL Server when defining sentinel tasks with the 
information captured from the incoming data stream.  It is 
then possible to execute a set of queries combined with 
stored procedure calls over different database systems for 
each block of data found by the sentinel.

Step 1 Select Database

Step 2 Click on Settings

Step 3 Enter a Task Definition File or click on Browse 
to search for an existing file

Step 4 Select ONE task from the list of configured 
tasks and click OK.

This task will be called up by default by the sentinel if the 
@TASK control variable is not set in the data stream.  

If you want to dynamically select the task
which would be called by the data stream
received by a sentinel, you must assign a
value to the @TASK control variable.
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Web Service 
Client

Its goal is to send data through WebService calls over the 
internet or intranet network.

•  Configuration To use web calls, you must first ask for the web service 
description file (WSDL file).  

Step 1 Open the WebService plug-in dialog box.
  
Step 2 Click on the ‘Add’ button.  

The WebService Resolution dialog box opens.  

Step 3 Type the WSDL address (URL) in the edit box 
and click on the green arrow.  

The plug-in will look for the service description.  If a user 
login and password is required, a dialog box will be opened 
to enter required values.  

Methods are listed in the table.  Method name followed by 
its parameters.  Parameters are indented.  If you click on a 
line, corresponding documentation will be shown on the 
bottom panel. 

To add a method to the plug-in’s usable method list, just 
enter an alias beside the method name.  You can also give 
an alias name to the parameter name.  When running senti-
nel, if parameters have an alias name, this one will be used 
as the variable resolution.  The sentinel’s  variable value  
will be sent to the corresponding parameter.  If the parame-
ter alias is omitted, its name will be used.  
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When methods are selected, you can close the Service 
Resolution dialog box.  Then in the configuration box, 
select the method to call from the plug-in as long as the 
@WEBMETHOD control variable of the plug-in is not set in 
the sentinel’s incoming data stream.

•  Web Service Test: You can test a method through the Web Service Resolution 
Dialog Box.  Open this dialog box, then click on the ‘test’ 
button.  A combo box allows you to select the method.  
Enter the parameter values and click on call.  If a result is 
sent back, it will be displayed in the result panel.

•  Limitation: During the sentinel process, the result from a web call can-
not be used nor interpreted.
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Output plug-ins

Transfer plug-in As for an output plug-in you can use the Transfer one.
This plug-in transfers input data to a specific directory 
according to the process result.
From the Output tab of the sentinel properties dialog box, 
select the output plug-in and click on Settings.
The following dialog box appears:

In the Folder for generated files zone, select where you 
want to save your file in case of failure or in case of suc-
cess.
In the Days to keep file zone, enter the number of days 
that the files will be kept.

The file name created by the output plug-in 

is identical to the name of the data set that 

is received by the input plug-in. If the same 
name is used for two different data sets,  

the old transferred file will be overwritten 

by the new one.
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The Days to keep file option is only activated 

when a sentinel sends a file to the Transfer plug-

in. If the plug-in is not used, files remain in the 

transfer folder whatever the time specified in the 

Days to keep files option is.
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Report plug-ins

You have three Report plug-ins at your disposal:
- Log file
- E-mail
- TCP/IP port listening

Log file This plug-in logs sentinel events in a text file. From the 
Report tab of the Sentinel properties dialog box, select 
the report plug-in and click on Settings.

The following dialog box appears:

Step 1 In the Log File tab, enter the file path. The gen-
erated log file name is made as follows: REPORT 
(<sentinel name>).txt

Step 2 Check one or several options of the Contents 
zone.
Step 3 Click on the Format tab to change the syntax of 
the file.

E-mail This plug-in sends an e-mail containing all the events cho-
sen.

From the Report tab of the sentinel properties dialog box, 
select the input plug-in and click on Settings.
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The following dialog box appears

Step 1 In the SMTP Server zone, enter your SMTP 
Server address and select your port.

The SMTP port number is commonly set to 25.

Step 2 Check the authentication box if your server 
requires authentification.  A username and password 
will have to be inserted.

Step 3 In the Recipients zone, enter the e-mail 
address of the person you want to contact when start-
ing or stopping, in case of error, or on warning.

Step 4 If you want to add several addresses for the 
same events, you have to separate them by a semico-
lon (;).

Step 5 In the From field, enter the sender’s address.
When you enter an address, the following icon displays . 
You can click this icon  to access to the Message for-

mat dialog box. 

Once you have entered your parameters, you can click on 
Cancel, or on Test  if you want to check the parameters you 
entered. Then the plug-in tries  to send an e-mail to all the 
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recipients that are specified. The e-mail sent uses the same 
format as the one specified in the settings of the plug-in so 
that you can check it. 

TCP/IP port 
listening

This plug-in is viewed as a Socket server and receives data 
from client in a pre-defined format. For more information 
about this format, please refer to the example available on 
the CD-ROM. This plug-in can be considered as an input 
and/or report plug-in. This plug-in can support any kind of 
platforms. For more information about this plug-in configu-
ration, please refer to the Input plug-in section of this 
chapter.
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